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Thank you for buying Castle software to compliment your Castle vibration meter.  
I am sure you will find the software and the service to be of the highest quality 
but if not, then please feel free to write to me personally and I will ensure that 
your needs are dealt with immediately. 
 
This manual is designed to show you the operation and features of the software 
you have purchased and a very brief insight into vibration itself.  If you would like 
to become a competent person in the eyes of the law, then you may like to know 
more about our Competent Persons training course for Human Vibration.  You 
can visit www.castle-training.com to find out more. 
  
It is my intention for Castle Group Ltd to provide a wide range of technical health 
and safety products and Services of the highest standard.  If you would like to 
know more about any of our other products and services then please telephone 
on +44(0)1723 584250 or visit www.castlegroup.co.uk  
 
 

 
 
Simon Bull 
Managing Director 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 

Copyright 
 
 

This manual is copyrighted with all rights reserved.  Copying in part or in whole is 
prohibited without the prior written consent of Castle Group Ltd. 

 
 
 

Minimum Requirements
 
Pentium III Processor or 100% compatible 
100MB Free disk space 
128MB Ram  
Windows 98SE, ME, 2000, XP, Vista or Windows 7 
[Minimum operating system requirements also apply] 
 
 

GA2001 
 
One free 9 pin RS232 Serial Communications Port 
or: - 
One free USB port (for use with a USB-Serial Adapter, available separately) 
 

GA2005 
 
One free USB port 
 
 
 

Contacting Castle Group
 
 
This manual contains complete operating instructions for the Castle software 
VibdataPro, read it carefully and you will quickly become familiar with its features 
and operation. 
 
If you do encounter problems with the operation of your software please feel 
free to contact customer support with your enquiry on: - 
 

Telephone: +44 (0)1723 584250
Fax: +44 (0)1723 583728
Website: www.castlegroup.co.uk
Email: techsupport@castlegroup.co.uk

sales@castlegroup.co.uk 
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Chapter 1 
 
 
 

Installing VibdataPro
 
The installation of VibdataPro requires full administrative privileges on a PC 
running Windows 7, 2000, XP or Vista to prevent installation issues.  Please 
seek advice from your IT manager if required. 
 
To install the VibdataPro vibration analysis software insert the CD into your CD 
or DVD ROM drive. 
 
The CD should auto run the setup program after a few seconds. If this does not 
happen then click the START button and select RUN.  
 
At the prompt type D:\SETUP.EXE. (Where “D” is the designated letter for your 
CD ROM drive). 
 
Then follow the on screen instructions. 
 
Once the installation is complete it is strongly recommended that you restart 
you computer before you try to load the program for the first time. 
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Chapter 2 
 
 
 

Communication Setup
 
The GA2005 communicates via a USB port whereas the GA2001 
communicates via a serial port. 
 
To communicate with the GA2005 a USB driver installed must be installed and 
the GA2001 must have correctly matched COM port assignments between the 
operating system and VibdataPro. 
 
If using a GA2001 and the installation PC does not have a 9 pin serial 
connection then a USB to serial adapter can be used.  Drivers must also be 
installed for these adapters and again COM port assignment must be matched. 
 
In this chapter each instrument type and the procedure for successful 
communication setup has been discussed.   
 
 
 
 
GA2001 Communication Setup 
 

VibdataPro will not communicate with the GA2001 range of vibration meters 
unless your instrument is connected to your PC successfully, follow the 
procedures detailed in this section to ensure correct connectivity. 
 
The software VibdataPro only operates on COM ports 1 through to 4 and only 
actively shows the ones that are available.  If they are not available for use then 
dBdataPro will not show the COM port. 
 
If COM ports are not available on your PC such as modern laptops, then you can 
purchase from Castle a USB to serial adaptor.  This plugs into one of your USB 
connections and then you simply plug the instruments download cable into this.  
The most common fault whilst using a USB to serial adaptor is that the supplied 
driver is not installed.  The supplied driver MUST be installed for the device to 
work correctly. 
 
The COM port settings in VibdataPro have to match the exact COM port that 
you have plugged your instrument into on your PC, this procedure is shown for 
both Standard Serial communication and if using a USB to Serial Adaptor. 
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Standard Serial Communication  
 
Start by determining which COM ports your PC is using, this can be achieved by 
the following: - 
 
Under Windows XP click on ‘Start’, ‘Control Panel’, ‘Performance & 
Maintenance’, ‘System’.  This will give the ‘System Properties’ window, from 
here click on the ‘Hardware’ tab and select ‘Device Manager’ which will give the 
following: - 
 
 

 
 
 
 

 
 
 
 
 
 
 
 
 
 
 

Open out ‘Ports (COM & LPT)’ to 
view the current settings. 
 
Determine which COM port is 
used by the Communications 
Port, here COM 1 is being used. 
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Now set VibdataPro settings to use COM port 1 (or what was determined from 
Device Manager), this can be achieved by the following procedure: - 
 
Highlight ‘Tools’ and select ‘Options’, the ‘Options’ window will open.  Select the 
tab named ‘General’ and locate the drop down box ‘Acquire From Serial Port’  
and select COM 1 (or what is shown under Device Manager).  Click OK to 
confirm the selection. 
 
 

 
 
 
 
 
 
 
 
 

Standard serial communication should now be complete and setup correctly.  
This procedure will need to be repeated each time the instrument is used on a 
different PC or if settings are overwritten. 
 
 
 

Change to the COM Port which is 
shown under Device Manager. 
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USB to Serial Adaptor Communication 
 
Connection via a USB to Serial Adaptor still produces the same transfer rate as 
a standard serial connection.  
 
Regardless of your operating system, you MUST install the driver which is 
located in the following folder: - 
 
‘C:\Program Files\Castle Group Ltd\VibdataPro\USB to RS232 Converter’ 
 
VibdataPro will not transfer data unless this driver is installed.  Follow the 
instructions supplied with the Adaptor to install the driver. 
 
Under Windows XP check that the driver is installed by clicking on ‘Start’ , 
‘Control Panel’ , ‘Performance & Maintenance’ , ‘System’.  This will give the 
‘System Properties’ window, from here click on the ‘Hardware’ tab and select 
‘Device Manager’ which will give the following: - 
 
 

 
 
 
If the USB Serial Port is showing a COM port that is beyond COM 4 then double 
click it as described to change the COM port assignment as highlighted: - 
 

Open out ‘Ports (COM & LPT)’ to 
view the current settings. 
 
 
 
 
Shown if the correct driver is 
installed.  Double click here to 
change COM port setting if 
required. 
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Click on the ‘Advanced’ tab: - 
 
 
 
 
 

 

Select a free COM port between 1 and 4 
from the drop down selection and click on 
OK to confirm. 
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You now need to follow ‘Standard Serial Communication’ to set the correct 
COM port within VibdataPro such that it matches the selection you made for the 
USB Serial Adaptor. 
 
You will not need to repeat this procedure if you always use the same USB 
connector, however if you install or remove other hardware it may be necessary 
to re-setup your USB and VibdataPro COM settings.  Likewise if you use the 
adapter on different PC’s then you will need to repeat the procedure. 
 
 

 
GA2005 Communication Setup 
 

VibdataPro will not communicate with the GA2005 range of vibration meters 
without the supplied USB driver being installed. 
 
Regardless of your operating system, you MUST install the relevant driver which 
is located on the VibdataPro installation CD and also copied to your installation 
folder during the setup procedure.  Please be aware that driver installation is 
only required the first time any unrecognized instrument is connected to your 
PC.   
 
Turn on the Excieo and connect the USB cable between the instrument and one 
of your PC’s USB ports.  With Windows XP, the system tray on your Windows 
desktop will display the message ‘Found new hardware Excieo Vibration 
Meter’ and the ‘Found New Hardware Wizard’ will begin, other MS Windows 
versions may have slight differences to the procedure below: - 
 

 
 

Select ‘No, not this time’ and click ‘Next’ 
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Select ‘Install from a list or specific location (Advanced)’ and click ‘Next’ 
 

 
 
Select ‘Include this location in the search’, ensuring that the displayed path is 
‘C:\Program Files\Castle Group Ltd\VibdataPro\Excieo Drivers’ and click 
‘Next’. 
 
For 64 bit operating systems you may need to use the following path:-
‘C:\Program Files (x86)\Castle Group Ltd\VibdataPro\Excieo Drivers’ and 
click ‘Next’. 
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The above message will be displayed, click ‘Continue Anyway’ and the driver 
‘Excieo – USB Serial Converter A’ will be installed. 
 
 

 
 
Click ‘Finish’ to close the Found New Hardware Wizard. 
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Repeat the process to install ‘Excieo – USB Serial Converter B’ 
 

 
 

 
 

Click ‘Finish’ to close the Found New Hardware Wizard and complete the driver 
installation. 
 
The system tray on your Windows desktop will display the message ‘Found new 
hardware, Your hardware is installed and ready to use’ and downloading 
recordings from a GA2005 will now be possible. 
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Chapter 3 
 
 

Running VibdataPro
 
VibdataPro can be run using either of the two options below: - 

1. During installation a shortcut  named VibdataPro is placed on your 
desktop, double click on this to start the application. 

 
2. Click the ‘START’ button and select ‘All Programs’, choose ‘Castle Group 

Software’ and finally select the application ‘VibdataPro’.  
 

Under 64 bit operating systems it may be necessary to update the path of 
the icon for both the above to the following: - 
 
‘C:\Program Files (x86)\Castle Group Ltd\dBdataPro\Castle.ico’ 

 
Opening Screen 
 

The display area is split into two sections.  
 

 
 
The left hand column named the ‘Data Browser’ will display details of any file 
opened within VibdataPro.   
 
The right hand area named the ‘Data Viewing Screen’ displays downloaded 
data and instrument information relevant to the recording.  
 
The Data Browser or Viewing Screen can be resized horizontally by grabbing 
and moving the column divider. 
 
At the top left of the screen is the toolbar which gives quick access to the 
commonly used functions within VibdataPro. 
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Toolbar Options – (No Recording Selected) 
 
With no active recording selected, the following toolbar options are available. 
 

File Menu 
 

Acquire  Download data from a GA2001 or Excieo 
New Create a new blank file 
Open Open a previously saved data file 
Save Save the current data to a file 
Save As Save the current data to a new file specifying 

a new name 
Close Close the active data file 
Close All Close all the open data files 
Print Print the currently selected data 
Exit Closes the application 
 

View Menu 
 

Toolbar  Toggles the toolbar on and off 
Options  Open the Options windows for VibdataPro  
  settings and user preferences 
 

Help Menu 
 

Contents View the help file 
Connect To Castle Website Opens Castle's Website in a browser window 
About VibdataPro for Windows… Display the current software version 
 

Toolbar Buttons 
 

 
 
From left to right, the buttons perform the following actions: 

Acquire Data Upload data from a GA2001 or GA2005 
Create New Folder Create a new blank folder 
Open File Open a previously saved data file 
Save File Save the current data to a file 
Print Print the currently selected data 
Copy to Clipboard Copy the selected data to the clipboard which 

can be pasted into other software such as 
word processors or spreadsheet applications 
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User Preferences and VibdataPro Settings 
 
 
 
 
 
 
 
 

To change user preferences and settings within VibdataPro, select ‘Options’ 
from the ‘View’ menu. 
 
 
 
 
 
 

General Tab 
 
 

 
 
 
Program Options 
This option is only available for the GA2005 range of vibration meters.   
 
Group by: 
Allows the grouping of logs in the tree view by either: - 
 
 
 
 

• Record, Employee (default), Tool, Location or Date 
 
Once used all logs in the active file will be grouped by the selected option, this 
option is therefore unavailable once a log has been downloaded into VibdataPro 
or a new working folder has been created. 
 



Page 14 

Options 
 
Company Name: 
Enter your company name here, which will be used when printing documents. 
 
Logo File: 
Use the button to point to the location of your company logo 
image file which will be used when printing documents. 
 
The image size is 150(W) * 50(H) pixels and must be in .bmp or .wmf format. 
 
 
File Options 
 
Default Datafile Directory: 
As with selecting a company logo, use the button  to point to a 
folder where you wish to save your data. 
 
 
Communication Options 
This option is only required for use with the GA2001 vibration meter. 
 
Acquire from Serial Port: 
Use this to select which COM port has been assigned to either a standard 
serial port or a USB to serial adapter. 
 
The COM ports available within VibdataPro are: - 
 

• 1, 2, 3 or 4 
 
This selection must match exactly to that defined by your operating system.  See 
‘Standard Serial Communication’ or ‘USB to Serial Adaptor Communication’ 
under ‘Chapter 2’ for detailed information. 
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Fields Tab 
 

 
 
This tab is used to select which information is displayed to the screen, copied to 
the clipboard and printed. 
 
Each measurement mode can be set independently using the drop down box 
labelled ‘Measurement Mode’.  The default selection is ‘Hand-Arm Vibration’.  
Likewise, deciding which data is to be copied, printed or displayed can also be 
set independently using the drop down box labelled ‘Data Format’ 
 

Use  or  to add or remove highlighted items to ‘Current 
Fields’ from ‘Available Fields’ and vice-versa. 
 

Use  or  to move the highlighted selection in ‘Current 
Fields’ up or down the list.  This will determine the order in which the parameter 
is displayed, copied and printed. 
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Display Tab 
 

 
 
Move the slider to adjust the line width used for graphing. 
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Criteria Tab 
 

 
 
Use this tab to change the Action and Limit Values for each operating mode 
where limit values are required.  
 
The criteria tab can also be used as a conversion tool.  Change the ‘Display 
Units’ to convert the action levels into the currently selected units.  The ‘dB 
Reference Value’ will only update the action levels if ‘dB’ is selected for the 
‘Display Unit’. 
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Chapter 4 
 
 

Opening, Acquiring and Saving Data
 
 
Acquiring Data 
 

Acquiring data from your instrument is achieved by connecting your instrument 
to your PC via the supplied interface cable. 
 
The supplied interface cable for use with the GA2005 range of vibration meters 
is a USB cable (type A to B). 
 
The supplied interface cable for use with the GA2001 range of vibration meters 
is a Lemo to ‘D’ connector serial cable.  If serial connections are not available on 
your PC then a USB to serial adapter maybe used (purchased separately). 
 
To acquire the data from your Castle Vibration Meter, follow the procedure 
below: - 
 
1. Ensure that the vibration meter is on and connected correctly to the PC. 

2. Select ‘Acquire’ from the File menu or click on the  icon. 

3. VibdataPro will now attempt communication with your Castle Vibration 
Meter. 
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4. If a response from your instrument is received then the list of available logs 
will be shown. 

 

 
 
Available logs can be sorted by name by clicking on the field name.  By default 
the list is sorted by ‘Employee’ and the sorted field can be identified by ‘>’ at the 
left of the field name.  The illustration below shows the list sorted by ‘Record’.  
The list order can be reversed by clicking the field name again. 
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5. Select which logs are required by clicking in individual tick boxes or by 
selecting ‘Select All’ and selecting which log types you wish to download. 
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6. If required select ‘Merge Folders’ and/or ‘Combine Logs’ using the tick 
boxes. 

 

 
 

Merging folders will allow newly acquired data to be merged into the current 
active folder that is open in VibdataPro.  If this option is not selected then the 
newly acquired data will be opened in a new folder. 
 
Combining logs works in conjunction with the user setting ‘Group by’ which 
is set under ‘Options’, ‘General’, ‘Program Options’. 
 
If ‘Combine Logs’ is selected, each log recorded in the same operating mode 
and with the same field name that falls under the category selected under 
‘Group by’ will be combined.  It is also possible to manually combine logs 
after acquiring or opening data. 
 

7. Once all preferences and files have been selected, press the OK button to 
start the download. 

 
8. If a response from your instrument is not received then you will be shown 

the following error message.  If this occurs please see ‘Chapter 2’ for 
instructions on communication setup. 
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Opening Data 
 

To open previously saved data choose ‘File’, ‘Open’ or press the  icon. 
 

 
 
 
The ‘Default Datafile Directory’ is the initial location where VibdataPro looks for 
files, this can be changed under ‘Options’ if required. 
 
To open the selected file double click on it or highlight it by a single click of the 
mouse button and then click on the ‘Open’ button. 
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Saving Data 
 

To save data to a log file choose ‘File’, ‘Save As’ or press the   icon.  
 

 
 
 
The ‘Default Datafile Directory’ is the initial location where VibdataPro saves 
data files, this can be changed under ‘Options’ if required. 
 
Enter a file name and then click on the ‘Save’ button. 

Once a file name has been specified quick saves are possible using the  
icon or ‘File’, ‘Save’.  To specify a new name if required, use ‘File’, ‘Save As’ 
again. 
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Chapter 5 
 
 

Using VibdataPro 
 
 
Data Browser 
 

The Data Browser is located at the left hand side of the screen.   It is used to 
select which information is displayed in the data viewing screen. 
 
The example below shows newly acquired data which has been grouped by 
employee. 
 

 
 
 
 
 
 
 
 
 
 
 
 
Clicking on the ‘+’ at the left of each mode type will open it out displaying the 
available logs. 
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The folder can be renamed if required by right clicking on the folder name and 
selecting ‘Rename Folder’. 
 

 
 
 
 
The example below shows that ‘Tools’ had been selected for the ‘Group by’ 
option. 
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Which ever ‘Group by’ option has been selected, it is possible to add new data 
to any of the operating modes.  To do this simply right click on the required 
operating mode name and select the new field record. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Enter a name for the new data field and press OK to accept.  The example below 
shows that the field ‘TRACTOR’ has been added. 
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Data Viewing Screen 
 

The Data Viewing Screen is the main area at the right hand side of the screen 
and is spilt into two sections if a recording is selected in the data browser. 
 
The top area displays all the recorded vibration data graphically or tabular 
whereas the bottom area of the data viewing screen shows information 
regarding your instrument and specific recording information. 
 
Viewing all the available recorded data is achieved using the selectable tabs that 
are located above the instrument information.  The tabs that are available are 
dependent on the mode of the recording, if VDV has been recorded and also if 
time history data has been recorded. 
 

Calculator Tab 
 
The Calculator tab displays the calculated variables selected under ‘Options’, 
‘Fields’ for the recording selected.  It is also possible to drag and combine 
recordings of the same mode and unit into the calculator screen.  The overall 
combined A(8) is then calculated on each recording that is in the calculator 
screen. 
 
The Calculator tab is always available for any recording. 
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Cumulative Data Tab 
 
To view cumulative data use the Cumulative Data tab. 
 
The cumulative data is a single overall figure calculated or measured over the 
measurement period for each available axis. 
 
Individual data for recordings that have been combined can be viewed but are 
selected at the calculator screen.  The information from the Calculator screen 
for the selected log is displayed at the top of the Cumulative Data screen to 
easily identify which recording is selected. 
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History(Table) Tab 
 
Where Interval data has been recorded with the log it is possible to view 
individual data points at each time history interval for each axis. 
 
To view the data in tabular format use the tab History(Table). 
 
To change the viewable data, select the required parameter from the drop 
down Display box. 
 
Individual data for recordings that have been combined can be viewed but are 
selected at the calculator screen.  The information from the Calculator screen 
for the selected log is displayed at the top of the History(Table) screen to easily 
identify which recording is selected. 
 
If a recording has been recorded without time intervals then the tabs 
History(Table) and History(Graph) will not be available. 
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History(Graph) Tab 
 
Where time history data has been recorded it is possible to view the history 
interval data in graphical format using the tab History(Graph). 
 
To change the viewable data, select the required parameter from the drop 
down Display box. 
 
 
Individual data for recordings that have been combined can be viewed but are 
selected at the calculator screen.  The information from the Calculator screen 
for the selected log is displayed at the top of the History(Graph) screen to easily 
identify which recording is selected. 
 
If a recording has been recorded without time history then the tabs 
History(Table) and History(Graph) will not be available. 
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VDV Calculator Tab 
 
Where recordings have VDV results then a VDV Calculator tab becomes 
available.   
 
The VDV Calculator tab displays the calculated variables selected under 
‘Options’, ‘Fields’ for the recording selected.  It is also possible to drag and 
combine recordings of the same mode and unit into the calculator screen.  The 
overall combined VDV is then calculated on each recording that is in the 
calculator screen. 
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Trend Analysis Tab 
 
Combined Single Axis recordings allow a Trend Analysis tab to become 
available. 
 
Use this tab to plot graphically the cumulative average for each individual 
recording within the combined set. 
 
The plot is graphed in the order the list is displayed in the Calculator screen and 
is useful for machine monitoring. 
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Toolbar Options – (Recording Selected) 
 
When an active recording is selected in the data browser the following toolbar 
options are available depending on which is the active viewing screen. 
 

File Menu 
 

Acquire  Download data from a GA2001 or Excieo 
New Create a new blank file 
Open Open a previously saved data file 
Save Save the current data to a file 
Save As Save the current data to a new file specifying 

a new name 
Close Close the active data file 
Close All Close all the open data files 
Print Print the currently selected data 
Exit Closes the application 
 

Edit Menu 
 

New Employee  Create a new empty recording 
Copy To Clipboard Copy current table or graph to clipboard 
Delete Employee Delete the selected measurement folder 
Print Current View Print the current view to installed PC printer 
Delete Measurement Delete the selected measurement 
Copy Measurement Copy the selected measurement data 
Paste Measurement Paste the copied measurement data 
Exclude Measurement Exclude the selected measurement from the 
  calculations 
Edit Exposure Time Enter a new value for the Exposure Time 
Edit Note Edit the displayed note field 
 
Note that where Employee is stated above, this is ‘Group By’ dependent; 
therefore if recordings have been grouped by Tool then replace instances of 
Employee with Tool, i.e. ‘New Tool’ 
 
The Edit Menu is also available by right clicking in the tabular or graphical 
viewing area of the Data Viewing screen. 
 

View Menu 
 

Toolbar  Toggles the toolbar on and off 
Options  Open the Options windows for VibdataPro  
  settings and user preferences 
 

Help Menu 
 

Contents View the help file 
Connect To Castle Website Opens Castle's Website in a browser window 
About VibdataPro for Windows… Display the current software version 
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Vibration Exposure Points 
 
The vibration exposure point system is based on the Health & Safety Executive’s 
system where vibration magnitude and exposure time are given in exposure 
points rather than ms-2. 
 
Partial exposure points of merged recordings are added together to produce a 
total points exposure for a working day.   
 
The exposure points calculated are: - 
 

• Partial Points 
• Points (1hr) 
• Points (15m) 

 
Partial points are displayed by default, Points(1hr) and Points(15m) will need 
selecting in order to be displayed, copied or printed.  See User Preferences and 
VibdataPro Settings under Chapter 3 for more information. 
 
Vibration exposure points are only available for recordings made in HARM or 
WBV mode with Metric units.  Each recording and the total exposure points are 
colour coded using the following criteria: - 
 
HARM 

>0 & <100 GREEN 
>=100 & <400 ORANGE 

>= 400 RED 
 
WBV 

>0 & <100 GREEN 
>=100 & <529 ORANGE 

>= 529 RED 
 
 
 
 
 
Printing 
 

Printing a default report is possible by using the Print Icon  or selecting Print 
Current View using the Edit Menu.   
 
The option Print Current View is only available whilst in the Calculator tab 
screen. 
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Chapter 6 
 
 

Warranty and After Sales Service
 
 
In the unlikely event of a fault or problem occurring with your software during its 
one year warranty period, it should be returned to Castle Group Ltd or to an 
authorized agent in its original packaging.  Please enclose a clear description of 
the fault. 
 
Castle Group Ltd 
Salter Road 
Cayton Low Road Industrial Estate 
Scarborough 
North Yorkshire 
England 
YO11 3UZ 
 
 
Should you have any queries regarding the use of the software or wish to 
suggest future improvements or additions then please feel free to contact 
technical support on techsupport@castlegroup.co.uk  
 
Castle Group Ltd reserves the right to update or amend the software or manual 
without notice.  
 
During the warranty period, upgrades or bug fixes will be issued free of charge 
when they become available. 
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Disclaimer 
 
Whilst every effort is made to ensure the accuracy and reliability of both the 
software described and the associated documentation, Castle Group Ltd makes 
no representation or warranties as to the completeness or accuracy of this 
information. 
 
Castle Group Ltd assumes no responsibility or liability for any injury, loss or 
damage incurred as a result of misinterpreted or inaccurate information. 
 
Any documentation supplied with your product is subject to change without 
notice. 
 
 
 
Software Details 
 
For your records and for future correspondence with Castle Group Ltd 
regarding your software, please complete the following details: - 
 

Software Version 

 

 
 

Serial Number 

 

 
 

Purchase Date 

 

 
 
 
 
 
 
 
 
 
 
 
 
 

Rev 1.2 


